
145

THE DATA EDITOR

THE DATA EDITOR

INTRODUCTION

This chapter explains how to use the Data Editor which enables you to edit
resources of any custom type whose structure can be described by a
Resorcerer template (‘TMPL’) resource.

Although the next section explains templates briefly, you will want to
become more familiar with ‘TMPL’ resources and how to create and edit
them, as described in the “Template Editor” chapter in the “Technical Stuff”
volume of this manual.

If you are not already familiar with general resource editing, you should
read the “Editing Resources” chapter earlier in this manual.

TOPICS COVERED

•     Resource templates
•     Creating a new custom resource
•     Opening a custom resource
•     How field values are displayed
•     Using the Data Editor
•     Editing individual fields
•     Cutting and pasting list items
•     Viewing options
•     Printing a custom resource
•     Closing your custom resource
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RESOURCE TEMPLATES

Along with all the standard Macintosh application resource types, your
application may need to keep private resources of its own custom types.
Typically, initialization values, tables of private data, configuration
parameters, etc., can be kept as individual resources in the resource fork of
your file.

Before you can create and edit a custom resource, you must design a
description of its structure and place the description into a resource
template, which is itself just a resource of type ‘TMPL’.

A template is a sequence of declarations of data fields that describe a wide
range of Macintosh data types (strings, words, bits, colors, rectangles, etc.).
The collection of declarations describes the data in the resource, scanned
from the beginning.  The Data Editor reads the sequence of fields from the
template, and uses them to create, parse, and display the data from your
custom resource in the sequence read.

In order for Resorcerer to distinguish which ‘TMPL’ resource describes which
resource type, you must set the first four characters of the ‘TMPL’s resource
name to the four-character custom resource type you are designing.

When you ask to create or edit a custom resource, Resorcerer searches for a
‘TMPL’ resource whose name begins with the same type as your custom
resource’s.  It first searches for a ‘TMPL’ in the same file as the one you are
editing (see the Note below, however).  If none is found there, Resorcerer
looks for a template among all files (in no particular order) within the
“Resorcerer® Templates” and “Private Templates” folders.  It first looks for
these folders in the same folder as the running copy of Resorcerer.  If the
template is not there, Resorcerer then looks for these folders in your System
folder.  If it still hasn’t found a matching ‘TMPL’, Resorcerer looks in its own
resource fork.  If none of these possible places has a ‘TMPL’ resource whose
name begins with the same four characters as your custom resource type,
then Resorcerer skips the Data Editor and uses the Hex Editor instead.

Note: You can alter the above search order using the Ignore ‘TMPL’s
in open files preference in the File Open Preferences section
of Resorcerer’s Preferences… command.  When this preference
is set, Resorcerer will always use a template found in one of the
template folders, even if another one is in the same file as the
resource you are opening.
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Resorcerer’s Template Editor lets you create and edit ‘TMPL’ resources, and
the “Template Editor” chapter gives the full details on what individual field
types are supported.

You can always tell whether a given resource has a template available by
looking at the Data button in the File Window.  If the button is enabled,
Resorcerer has already found a template to use; otherwise none is available.

Note: For any given resource type, there should be only one ‘TMPL’ that
describes it among the collection of templates in the collection of
files in the “Resorcerer® Templates” and “Private Templates”
folder.  Resorcerer will warn you about any duplicates every time
it scans or rescans the template folders.

Note: You cannot edit a custom resource if the ‘TMPL’ that describes it
is already open and being edited with the Template Editor.

Sorcery: If you hold the Option key down while clicking in the File
Window’s Open or New buttons, or in the New Resource
dialog’s Create button, you force Resorcerer to bypass any
dedicated editor for the resource type in question in favor of the
Data Editor.

CREATING A NEW CUSTOM RESOURCE

To create a new custom resource whose ‘TMPL’ exists somewhere in
Resorcerer’s collection of templates, make the Types List of your file the
Active List and click on the New button (or choose New Resource from the
Resource menu).  Or, if you already have resources in the file of the same
custom type, make the Resources List that displays them the Active List and
invoke the New Resource command.  In the former case, Resorcerer will
ask you to specify the resource ID, name, and attributes first; in the latter
case, it will assign defaults.

Resorcerer looks up the matching ‘TMPL’ resource (see the previous section
on how it searches for the match), checks to make sure the ‘TMPL’ doesn’t
have any errors in it, and then asks the Data Editor to create the custom
resource’s new data.

The Editor creates the data by assigning default values for each data field
described in the ‘TMPL’.  The default value assigned to each data field is
usually whatever is required to make the field empty.  For example,
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numerical fields are set to zero, but the count value for a zero-based list
count field (‘LSTZ’) is set to -1, since this value implies the list is empty.
‘CHAR’ fields are set to a single space character, whereas ‘DBYT’ fields are
set to 0.  ‘TNAM’ fields are set to ‘????’.

However, if a field has one or more ‘CASE’ fields describing important
values, then the Editor takes the value of the first ‘CASE’ as the default.
This lets you avoid errors where the standard hard-wired default is not a
legal value for your resource field.  For instance, many resources begin with
a version word that is typically non-zero.  Using a ‘CASE’ definition for this
non-zero value, the Editor can set the new field automatically for you.

Once the new data is created, the Editor opens it as described below.

OPENING A CUSTOM RESOURCE

To open an existing custom resource whose ‘TMPL’ can be found somewhere
in Resorcerer’s collection of templates, select the resource in the Resources
List and click on the Data button.  Or if the resource would not normally be
edited with one of Resorcerer’s dedicated Editors, use the usual Open button
or double-click on the resource entry directly.

Resorcerer looks up the matching ‘TMPL’ resource, checks to make sure the
‘TMPL’ doesn’t have any errors in it, and then asks the Data Editor to parse
the custom resource’s data into the fields specified by the template.  The
Data Editor then creates a standard Resorcerer list in which each entry
corresponds to a field from the template.

Note: If the ‘TMPL’ contains the special ‘FLTR’ field, the Data Editor
will pre- and post-process the resource data using the filter
(‘FLTR’) resource associated with this ‘TMPL’.  For more on
filtered templates, see the “Designing Filters” section in the
“Template Editor” chapter.

TOO MUCH DATA

Sometimes a resource will contain more data than is described by the
template the Editor is using.  This can happen when the template has
been changed but the data hasn't, or when the resource data is
corrupted in some way.

In this case, the Editor will inform you where the logical end of the
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resource data is,
how much extra
data was found, and
ask you whether you
want to keep the
extra bytes while
editing the defined
fields, or throw the extra data out in order to conform the resource to its
description.

Note: You will get this alert often when opening resources in your
Macintosh ROM (the “System ROM Resources” file) with a
template.  As of this writing (System 7.1), a bug in the Resource
Manager causes it to deliver most resources from the ROM with
extra data appended past their logical ends.

TOO LITTLE DATA

It is also possible for the Editor to reach the end of the resource data
before hitting the end of the template fields describing the resource.
Usually this is because the resource data is corrupted, or because you
have added a field to a template, or the resource has been compressed
with a third-party utility.  Whatever the reason, the Editor will alert
you to the problem.  You can either Cancel or Continue opening.  If
you continue opening, the Editor fills in all missing fields at the end of
the resource with default values, as if the fields were being created as
part of a new resource.  The fields are marked as having been changed,
so you can tell exactly where the created (missing) data began.

  Sorcery: The Select…Changed command in the Edit menu
scrolls you directly to the first appended fields.
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HOW FIELD VALUES ARE DISPLAYED

The Data Editor scans the template for your custom resource (shown below
on the left) and displays the fields from your custom resource in a standard
scrollable Resorcerer list (shown below on the right).  The Grow Box in the
list’s lower right corner lets you change its size; the Zoom Box in the list’s
drag bar zooms the window on the screen on which it finds itself.

Any field in the Editor list is selectable and in general corresponds to one
field value from the template.  The label string (taken from the ‘TMPL’ data)
is printed in boldface if it is associated with a value that you can change.

This helps draw your eye to those fields that are most worth attending to.
Currently, field types that can’t be edited include ‘FBYT’, ‘FWRD’, ‘FLNG’,
‘AWRD’, ‘ALNG’, ‘HEXD’; any bit field whose title is “Reserved”, “Unused”,
or “Filler”; any ‘SKIP’ offset type field; any ‘DVDR’ field; and any of the list
delimiting fields ‘LSTB’, ‘LSTC’,  ‘LSTZ’, and ‘LSTE’.

Following the label is the value of the field, decoded according to the field
type.  The field type is normally not displayed (although see the “Viewing
Options” section later in this chapter).  If the field value corresponds to one
of a field’s symbolic ‘CASE’ values, then the symbolic case string is



151

THE DATA EDITOR

displayed, along with the value it matches, separated by an ‘=’ sign.

Decimal number values are displayed as is; hex numbers are zero-padded
according to the size of the field in bytes (i.e. 2, 4, or 8 bytes) preceded by a
‘$’ sign; single characters and four-character types are displayed in single
quotes; character strings are displayed surrounded by double quotes.

Bits and bit fields precede the label string with the actual bit number(s)
representing the field (most significant bits are displayed first); the value of
single bits is displayed as either “On” or “Off”; the value of a ‘BOOL’ field is
displayed as either “True” or “False”.

Single, double, and extended 80- and 96-bit precision floating point numbers
are displayed according to the number of significant digits specified in any
format escape sequence that is appended to the label string (for more on this,
see the “Template Editor” chapter).  Fixed  and Fract  numbers are
displayed in decimal fixed point.

Points, RGB colors, and rectangles are displayed as a parenthesized list of
two, three, and four values, respectively, preceded by a label that keeps you
from having to remember which value in the list is which.  For example, the
value of a ‘RECT’ field is displayed as “(t,l,b,r)=(100,60,148,460)”, where
“(t,l,b,r)” stands for “(top,left, bottom,right)”.  RGB color fields are also
displayed graphically on color displays.

System date fields are converted from their internal long word integer form
and displayed as a date and time string.

Sometimes the template indicates that the resource should consist of a list of
items (in our ‘SPUD’ example on the previous page, there is a counted list
consisting of 1 “widget” item).  In this case, the Editor indents and encloses
the set of fields comprising each item with gray (blue on color systems) lines
bordering the top, left, and bottom, and extending as far to the right as
necessary.  Each item is labeled with its index along the top horizontal line;
if the template list is empty, then the label “No Items” is displayed.

The values of skip offset fields (‘BSKP’, ‘SKIP’, and ‘LSKP’) are not shown
unless you have the Show Offsets viewing option turned on.
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USING THE DATA EDITOR

Like other Resorcerer lists, you can click on any field to select it, Shift-click
to extend the selection, and c-click to toggle the selection status of any cell
without changing any others.

On either side of the list are two
triangular handles that let you
position the list insertion caret.  If no
list entries are selected, the list caret
will blink horizontally between these
two handles.  You can scroll the list
by dragging a handle above or below
the list boundary.

Underneath the field list are three
buttons labeled Edit, New, and
Cancel.

The Edit button opens an editing
window for every selected field that
supports an editing window.  Fields
whose labels are not in boldface are ignored, as are certain other fields (such
as ‘OCNT’ and ‘ZCNT’ fields, which you never need to edit because they are
updated automatically).  For more on editing fields, see the next section,
“Editing Individual Fields”.  As with other Resorcerer Editors, if the field
was selected as the result of a Find All… text search, the first instance of
matching text in the field will be automatically selected when you open it.

Double-clicking on a cell opens it for editing in the same way as when you
use the Edit button.  As you make changes, they are immediately reflected
in the list entry.  When you finish editing a field, click in the OK button or
the window’s GoAway box.  Changed fields are marked on the left with a
small dot to let you know which fields you’ve worked on.

The New button lets you create and insert a new template list item.  The
button is only enabled when the list insertion caret is directly below a
horizontal divider line that represents the top of a repeated item.  Choosing
New Item from the Custom menu is equivalent to using the New button.
When the new item is created, its horizontal divider line is marked as
changed to indicate that the whole item is new.
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Alternate keyed items are bounded by solid black lines; repeated list items
are bounded by gray (or blue) lines.  These lines help you see the structure
and nesting level of more complicated resources.

Popup boxes on the left side of any field let you choose from among a
collection of important values, as defined in ‘CASE’ fields in the template.  If
the field is a key field, then choosing different key values with the popup
causes the structure of the following keyed item to change accordingly.  After
changing either a normal field or a key and its keyed structure, you can
choose Undo to restore the old value(s).

The Cancel button lets you discard any of the changes you may have made
since opening.

Sorcery: Double-clicking on a list insertion caret handle is the same as
clicking the New button to create a new template list item at the
position of the horizontal item divider directly above the insertion
caret line.

Select All selects all fields in the resource, or if one of an item’s
fields is already selected, it selects all fields in that item.

Option-double-clicking on a ‘RSID’ field opens the referenced
resource whose type is found in the field label, or in the closest
previous ‘TNAM’ field at the same or previous nesting level.

Option-double-clicking on a ‘RECT’ field lets you screen copy the
coordinates graphically from a background window.

The Up and Down arrow cursor keys move the selection up or
down one field at a time.

The Right arrow cursor key moves the selection forward by one
template list item at a time, at the current indentation level.
The Left arrow cursor key moves the selection backward by one
template list item at a time, at the current indentation level.

Option Up arrow scrolls the list to the first field.
Option Down arrow scrolls the list to the last field.
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EDITING INDIVIDUAL FIELDS

Each time you open a field for editing, the Data Editor places a • (bullet)
next to the field to indicate that it is open for editing in its own window.  The
value of the field is converted to a string and presented to you to edit using
the Mac’s standard text editing procedures.

If the template describing
the field you’ve opened
has one or more
associated ‘CASE’ fields,
they will have been
collected together in order
to create a popup menu of
all symbolic case names
(‘CASE’ fields are not
displayed in the resource
window’s field list).  When
you choose one of the
cases from this menu, the
value of the symbolic
constant is entered
automatically for you in the editing box below.

The title of the window contains the four-character ‘TMPL’ type code to show
you the type of data the field represents.  The field label is copied into the
window as well, to remind you what it’s all about.

The Editor opens single bit
(‘BBIT’, ‘WBIT’, ‘LBIT’, ‘BB01’,
‘WB01’, ‘LB01’, ‘BFLG’, ‘WFLG’,
‘LFLG’) and Boolean (‘BOOL’)
fields into a window that lets you
choose one of two radio buttons to
specify the binary value.
However, you will probably want to use the Toggle Value command in the
Custom menu, which gets the job done more quickly.  Most other field types
must be opened before you can change them.

Single numerical fields are edited in a straightforward way.  Hex fields
(‘HBYT’, ‘HWRD’, and ‘HLNG’) fields should begin with a ‘$’, although this is
optional.  Decimal integer (‘DBYT’, ‘UBYT’, ‘DWRD’, ‘UWRD’, ‘DLNG’, and
‘ULNG’) fields will automatically convert a hex constant beginning with a ‘$’
to decimal when you close the field.
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Multiple-bit fields are converted to unsigned decimal, and you can enter
either decimal or hex constants as long as the value is less than the
maximum size number that will fit in that many bits.  The Editor will warn
you if the number is too large.

Multiple numerical fields (‘PNT ’
and ‘RECT’) are edited in a single
text editing field.  The values are
placed in a parenthesized, comma-
separated list preceded by a
similar list of hint labels to show
you which value is which.  When
you close the field, the Editor scans the text from the end, parsing the list of
two or four numbers, and ignores all label text prior to the list of values.
You can set the rectangle coordinates graphically by clicking the Set button.
If the marching ants are completely within another Resorcerer window, the
rectangle is recorded in the local coordinates of that window; otherwise, they
are recorded as global screen coordinates.

In the case of ‘COLR’ fields, a
standard Resorcerer color box is
displayed.  To use the Mac’s
Standard Color Picker to set the
color values, click on the Set
button, or double-click on the color
box directly.  As with all color
boxes in Resorcerer, you can
Copy and/or Paste the color to and from any similar color box in any editor.

You can enter the value of a ‘CHAR’ field either as a single character or as a
hex byte (a ‘$’ followed immediately by two hex digits).  ‘CHAR’ fields with
unprintable character values (less than $20) are initially shown in hex.

‘HEXD’ fields are not editable; however, you can use the Show Offsets
command in the Custom menu to see the offset into the resource data at
which the first byte of the ‘HEXD’ field begins, so that you can use the Hex
Editor to view and edit the rest of the resource data at that offset.

To close the field value, click in the window’s Go Away box, or choose Close
Resource Item from the Resource menu.  If you’ve made any changes to
the field, the Editor displays the field back in the main list with a small dot
next to it to indicate that you’ve worked on it.
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CUTTING AND PASTING LIST ITEMS

Individual data fields in the Data Editor field list cannot be cut or pasted,
since you can’t arbitrarily rearrange the order of fields in your custom
resource (editing the ‘TMPL’ is how you would do that).  However, when your
custom resource contains a list of repeated items, each of which has the
same structure, you can cut and paste these items within their own lists.

When a set of fields in your custom resource comprises a repeated list item,
the Editor list cell directly above the first field in the item contains the item
number and a label, embedded in a horizontal divider line.  The divider line
acts as a handle to the entire set of fields in the repeated item.  When you
select the divider line, the item as a whole is considered selected.

To cut, clear, or copy all fields of a repeated list item, select the horizontal
line in the cell above the item’s first field, and choose Cut, Clear, or Copy
from the Edit menu.  This compiles the item data, along with other
information, and puts it in the clipboard.

To paste an item, first place the list insertion caret at the position where you
want to insert the item from the clipboard.  The insertion position is just
after any horizontal divider line in the same list as the item came from.
Then choose Paste from the Edit menu.  After the paste, the Editor places
the insertion caret at the appropriate position just after the item pasted so
that subsequent Paste commands continue to append copies of the item to
the list.  The top divider line field of each inserted item is marked changed.

Note: Normally, you can’t cut and paste items except within their own
lists.  However, repeated list items from recursive lists (for more
on these, see the ‘SELF’ field described in the “Template Editor”
chapter) can be cut, copied, and pasted among all the recursive
instances of the list anywhere in the resource.

VIEWING OPTIONS

During editing, you can ask the Data Editor to show
you various pertinent field information that you may
need to know on occasion, or to help you navigate
within large or complex lists.
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SHOWING FIELD TYPES

To be able to see the individual four-character field types, choose Show
Field Types from the Custom menu.  Each type is displayed in
parentheses to the left of the field label.  When this option is on, any
floating point formatting command appended to the label string of a
‘REAL’, ‘DOUB’, ‘EXTN’, ‘XT80’, ‘XT96’, or ‘UNIV’ field also is displayed
in parentheses, to the right of the label.

SHOWING FIELD OFFSETS

Each field that represents
data begins at a specific
offset from the beginning of
the resource.  To make the
offset at which each field
starts visible, choose Show
Offsets from the Custom
menu.  Each offset is drawn,
in brackets, to the left of the
label string, in hex.

The offset for consecutive bits
or bit fields remains the same
as long as the bit fields occur
in the same underlying chunk
of data (byte, word, or long).
For instance, the offset of each bit within a word (a set of ‘WBIT’ fields)
will be the same as the word’s offset.

  Note: If you are editing pre-processed resource data using a
filtered template, and the filter has not set the
sameOffsets  bit in the FilterRecord , the offsets
displayed refer only to the intermediate form of the data
you are editing.  The offsets of the fields in the post-
processed resource data will be different (somewhere).
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DECIMAL OFFSETS

To convert the offsets being displayed with the Show Offsets command
described above from hexadecimal to decimal, choose Decimal Offsets
from the Custom menu.  Decimal offsets are also drawn inside a set of
brackets, but with no leading 0’s or ‘$’ sign.

SHOWING THE TEMPLATE’S FILE

To see which file the template the Data Editor is using to parse the
resource you’re looking at, use the Show Template’s File… command.

SETTING THE TEXT DISPLAY FONT

To change the style that text is displayed in,
choose Set Text Style… from the Resource
menu.  After setting the font and size, click in the
OK button to make the change to the frontmost
Data Editor window.  The Save & OK button lets
you install the text style you’ve set as the Data
Editor’s default style, which it uses each time you
open a custom resource.

SHOWING INDEX POPUPS

For certain large
resources, such as
‘aete’ or ‘aeut’
resources, with
muliply nested lists of
complicated items, it is
useful to be able to
scroll directly to a
given item.  To do this,
turn Show Index
Popups on.  This tells
the Data Editor to
display small popup boxes (similar to CASE popups) at the start of each
list item divider line.  Clicking on any of them lets you choose where in
the list you want to be.



159

THE DATA EDITOR

PRINTING A CUSTOM RESOURCE

To print your custom resource editing session, choose Print to Printer…
from the File menu.  The Editor prints all selected fields in the resource
field list as they look on your screen, with the exception that popup boxes are
suppressed to save space (unless you hold the Option key down).  If no fields
are selected, it prints the entire resource field list.

CLOSING YOUR CUSTOM RESOURCE

When you are through editing fields and list items in your custom resource,
click in the Editor window’s Go Away box to close the resource and save your
changes back to the in-memory copy of your file.

The Editor scans the fields from the beginning of the list in order to compile
the resource data back to its machine-readable form.  If the Editor has been
using a filtered template, it then passes the data just compiled to the filter,
which post-processes the data into its final form.  For more on filtered
templates, see the “Designing Filters” section of the “Template Editor”
chapter.
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